Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.
Table of Contents

Chapter 1. Introduction
  1.1 Noise Suppression Library Overview ......................................................... 11
  1.2 Features ..................................................................................................... 12
  1.3 Host System Requirements ........................................................................ 12

Chapter 2. Installation
  2.1 Installation Procedure ................................................................................ 13
  2.2 Noise Suppression Library Files ................................................................. 13

Chapter 3. Quick Start Demonstration
  3.1 Quick Start Demonstration for dsPIC33F Device Family ......................... 17
  3.2 Quick Start Demonstration for dsPIC33E Device Family ......................... 22

Chapter 4. Application Programming Interface (API)
  4.1 Adding the Noise Suppression Library to an Application ....................... 25
  4.2 Library Usage ........................................................................................... 26
  4.3 Resource Requirements ............................................................................ 28
  4.4 Noise Suppression Library API Functions ................................................. 29
  4.5 Application Tips ....................................................................................... 49
Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and documentation are constantly evolving to meet customer needs, so some actual dialogs and/or tool descriptions may differ from those in this document. Please refer to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each page, in front of the page number. The numbering convention for the DS number is “DSXXXXX A”, where “XXXXX” is the document number and “A” is the revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This preface contains general information that will be useful to know before using the dsPIC® DSC Noise Suppression Library. Items discussed in this chapter include:

- Document Layout
- Conventions Used in this Guide
- Warranty Registration
- The Microchip Web Site
- Development Systems Customer Change Notification Service
- Customer Support
- Document Revision History

DOCUMENT LAYOUT

This user’s guide describes how to use the dsPIC DSC Noise Suppression Library. This user’s guide is composed of the following chapters:

- **Chapter 1. “Introduction”** – This chapter introduces the dsPIC DSC Noise Suppression Library and provides a brief overview of noise suppression and the library features. It also outlines requirements for a host PC.
- **Chapter 2. “Installation”** – This chapter provides detailed information needed to install the Noise Suppression Library demonstration on a PC.
- **Chapter 3. “Quick Start Demonstration”** – This chapter provides a hands-on demonstration of noise suppression in a working application.
- **Chapter 4. “Application Programming Interface (API)”** – This chapter outlines how the API functions provided in the dsPIC DSC Noise Suppression Library can be included in your application software through the API.
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial font:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td><em>MPLAB® IDE User's Guide</em></td>
</tr>
<tr>
<td></td>
<td>Emphasized text</td>
<td><em>...is the only compiler...</em></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>the Output window</td>
</tr>
<tr>
<td></td>
<td>A dialog</td>
<td>the Settings dialog</td>
</tr>
<tr>
<td></td>
<td>A menu selection</td>
<td>select Enable Programmer</td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>&quot;Save project before build&quot;</td>
</tr>
<tr>
<td>Underlined, italic text with right angle bracket</td>
<td>A menu path</td>
<td><em>File&gt;Save</em></td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click <strong>OK</strong></td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A tab</td>
<td>Click the <strong>Power</strong> tab</td>
</tr>
<tr>
<td>Courier New font:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain Courier New</td>
<td>Sample source code</td>
<td><code>#define START</code></td>
</tr>
<tr>
<td></td>
<td>Filenames</td>
<td><code>autoexec.bat</code></td>
</tr>
<tr>
<td></td>
<td>File paths</td>
<td><code>C:\mcc18\h</code></td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td><code>_asm, _endasm, static</code></td>
</tr>
<tr>
<td></td>
<td>Command-line options</td>
<td><code>-Opa+, -Opa-</code></td>
</tr>
<tr>
<td></td>
<td>Bit values</td>
<td><code>0, 1</code></td>
</tr>
<tr>
<td></td>
<td>Constants (in source code)</td>
<td><code>0xFF, ‘A’</code></td>
</tr>
<tr>
<td>Italic Courier New</td>
<td>A variable argument</td>
<td><code>file.o, where file can be any valid filename</code></td>
</tr>
<tr>
<td>Square brackets []</td>
<td>Optional arguments</td>
<td><code>mcc18 [options] file [options]</code></td>
</tr>
<tr>
<td>Curly brackets and pipe character: {}</td>
<td>Choice of mutually exclusive arguments; an OR selection</td>
<td>`errorlevel {0</td>
</tr>
<tr>
<td>Ellipses...</td>
<td>Replaces repeated text</td>
<td><code>var_name [, var_name...]</code></td>
</tr>
<tr>
<td></td>
<td>Represents code supplied by user</td>
<td><code>void main (void) { ... }</code></td>
</tr>
</tbody>
</table>
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Sending in the Warranty Registration Card entitles users to receive new product updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use the dsPIC DSC Noise Suppression Library. The following Microchip documents are available from the Microchip web site (www.microchip.com), and are recommended as supplemental reference resources.

dsPIC30F Family Reference Manual (DS70046)
Refer to this document for detailed information on dsPIC30F device operation. This reference manual explains the operation of the dsPIC30F Digital Signal Controller (DSC) family architecture and peripheral modules but does not cover the specifics of each device. For more information, refer to the specific device data sheet.

dsPIC33F/PIC24H Family Reference Manual
Refer to this document for detailed information on dsPIC33F/PIC24H device operation. These reference manual sections explain the operation of the dsPIC33F/PIC24H DSC family architecture and peripheral modules, but do not cover the specifics of each device. For more information, refer to the specific device data sheet.

Refer to this documents for detailed information on dsPIC33E/PIC24E device operation. These reference manual sections explain the operation of the dsPIC33E/PIC24E DSC family architecture and peripheral modules, but do not cover the specifics of each device. For more information, refer to the specific device data sheet.

16-bit MCU and DSC Programmer’s Reference Manual (DS70157)
This manual is a software developer’s reference for the 16-bit PIC24F and PIC24H MCU and 16-bit dsPIC30F and dsPIC33F DSC families of devices. It describes the instruction set in detail and also provides general information to assist in developing software for these device families.

MPLAB® Assembler, Linker and Utilities for PIC24 MCUs and dsPIC® DSCs User’s Guide (DS51317)
MPLAB Assembler for PIC24 MCUs and dsPIC® DSCs (formerly MPLAB ASM30) produces relocatable machine code from symbolic assembly language for the dsPIC DSC and PIC24 MCU device families. The assembler is a Windows console application that provides a platform for developing assembly language code. The assembler is a port of the GNU assembler from the Free Software Foundation (www.fsf.org).

MPLAB® C Compiler for PIC24 MCUs and dsPIC® DSCs User’s Guide (DS51284)
This document describes the features of the optimizing C compiler, including how it works with the assembler and linker. The assembler and linker are discussed in detail, in the "MPLAB® Assembler, Linker and Utilities for PIC24 MCUs and dsPIC® DSCs User’s Guide" (DS51317).

MPLAB® IDE Simulator, Editor User’s Guide (DS51025)
Refer to this document for more information pertaining to the installation and implementation of the MPLAB® Integrated Development Environment (IDE) Software.
THE MICROCHIP WEB SITE

Microchip provides online support via our web site at: http://www.microchip.com. This web site makes files and information easily available to customers. Accessible by most Internet browsers, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listings
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listings of seminars and events; and listings of Microchip sales offices, distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://www.microchip.com, click **Customer Change Notification** and follow the registration instructions.

The Development Systems product group categories are:

- **Compilers** – The latest information on Microchip C compilers and other language tools. These include the MPLAB® C compiler; MPASM™ and MPLAB 16-bit assemblers; MPLINK™ and MPLAB 16-bit object linkers; and MPLIB™ and MPLAB 16-bit object librarians.
- **Emulators** – The latest information on the Microchip MPLAB REAL ICE™ In-Circuit Emulator.
- **In-Circuit Debuggers** – The latest information on the Microchip In-Circuit Debuggers, MPLAB ICD 3 and MPLAB PICkit™ 3.
- **MPLAB® IDE** – The latest information on Microchip MPLAB IDE, the Windows® Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager and general editing and debugging features.
- **Programmers** – The latest information on Microchip programmers. These include the MPLAB PM3 device programmer and the PICkit™ 3 development programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through our Microchip web site at: http://www.microchip.com/support
DOCUMENT REVISION HISTORY

Revision D (August 2008)

This revision includes the following updates for version 5.0 of the Noise Suppression Library. The previous version of the library was 4.0.

This document has been renamed from "dsPIC30F Noise Suppression Library User’s Guide" to its new name of “dsPIC® DSC Noise Suppression Library User’s Guide”. There has been no change to the Microchip literature number (DS70133) other than a revision letter update.

Each chapter has been extensively reworked and reorganized to support all dsPIC DSC devices. The previous version of the document contained seven chapters, which have been consolidated as described in the following table:

<table>
<thead>
<tr>
<th>TABLE 1-1: MAJOR UPDATES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter Name</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Chapter 1. &quot;Introduction&quot;</td>
</tr>
<tr>
<td>Chapter 2. “Installation”</td>
</tr>
<tr>
<td>Chapter 3. “Quick Start Demonstration” (formerly Chapter 6. Noise Suppression Demo)</td>
</tr>
<tr>
<td>Chapter 4. “Application Programming Interface (API)”</td>
</tr>
</tbody>
</table>
Revision E (June 2011)

This revision includes the following updates for version 6.0 of the Noise Suppression Library. The previous version of the library was 5.0.

<table>
<thead>
<tr>
<th>TABLE 1-2: UPDATES</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter Name</td>
<td>Update Description</td>
</tr>
<tr>
<td>&quot;Preface&quot;</td>
<td>Updated the “Recommended Reading” section</td>
</tr>
</tbody>
</table>
| Chapter 1. "Introduction" | • Updated the first paragraph in Chapter 1. “Introduction”  
   • Updated the list of minimum characteristics that a PC-compatible host system requires, in 1.3 “Host System Requirements” |
| Chapter 2. “Installation” | • Updated 2.1 “Installation Procedure”  
   • Removed FIGURE 2-1 through FIGURE 2-5 in 2.1 “Installation Procedure”  
   • Removed the Note in 2.1 “Installation Procedure”  
   • Updated the directory labeled NS v5.0 to NS v6.0 in 2.2 “Noise Suppression Library Files”  
   • Updated Table 2-1 in 2.2.1 “demo Folder”  
   • Updated Table 2-3 in 2.2.4 “lib Folder”  
   • Updated 2.2.4 “lib Folder” |
| Chapter 3. “Quick Start Demonstration” | • Updated the first paragraph in Chapter 3. “Quick Start Demonstration”  
   • Updated 3.1 “Quick Start Demonstration for dsPIC33F Device Family”  
   • Updated the project name in step 1 and file name in step 2, in 3.1.2.2 “Programming the dsPIC DSC Device”  
   • Removed FIGURE 3-3 and FIGURE 3-4 in 3.1.2.2 “Programming the dsPIC DSC Device” |
| Chapter 4. “Application Programming Interface (API)” | • Removed FIGURE 4-1 through FIGURE 4-3 in 4.1 “Adding the Noise Suppression Library to an Application”  
   • Updated step 4 in 4.1 “Adding the Noise Suppression Library to an Application”  
   • Added Step 1 in 4.2 “Library Usage”  
   • Updated Example 4-1 in 4.2 “Library Usage”  
   • Added a note in 4.2 “Library Usage”  
   • Updated Table 4-1, Table 4-2 and Table 4-4, in 4.3 “Resource Requirements” |
Chapter 1. Introduction

The dsPIC DSC Noise Suppression Library provides an algorithm to suppress the effect of noise in a speech signal. The library supports the dsPIC33F and dsPIC33E device families. This chapter provides an overview of the library, and covers these topics:

- Noise Suppression Library Overview
- Features
- Host System Requirements

1.1 NOISE SUPPRESSION LIBRARY OVERVIEW

The Noise Suppression Library is useful for microphone-based applications in which the incoming speech (audio) signal is susceptible to ambient noise. This library is especially suitable for systems such as hands-free cell phones, speaker phones, intercom and teleconferencing systems, headsets, and in general, any microphone-based application that needs to eliminate unwanted noise. The Noise Suppression Library does not need an additional acoustically isolated noise reference.

The Noise Suppression Library is written almost entirely in Assembly language. It is highly optimized to make extensive use of the dsPIC Digital Signal Control (DSC) device architecture including its Digital Signal Processor (DSP) instruction set and advanced addressing modes. The algorithm has been implemented keeping in mind the need to avoid data overflow. The library functions can be easily called by the user application through a well-documented Application Programmer’s Interface (API).

The Noise Suppression function removes noise from a 10 ms block of 16-bit speech data sampled at 8 kHz. This function is primarily a Frequency Domain algorithm in which a Fast Fourier Transform (FFT) is performed on each 10 ms block of data to analyze the frequency components of the signal. Thereafter, a Voice Activity Detection (VAD) algorithm is used to determine if the signal segment is speech or noise. The Noise Suppression algorithm maintains a profile of the noise and updates it every time a noise segment is detected by the VAD. Every frequency band of the input signal is then scaled according to the proportion of noise contained in that frequency band, thereby causing a significant degree of noise suppression in the resultant signal. The algorithm adapts to changes in the nature and level of noise and does not require a separate noise reference input.

Figure 1-1 illustrates a simplified block diagram of a user application using noise suppression.

FIGURE 1-1: NOISE SUPPRESSION IN AN APPLICATION
1.2 FEATURES

The dsPIC DSC Noise Suppression Library provides the following features:

- Simple user interface with only one library file and one header file
- All functions are called from a C application program
- Full compliance with the Microchip C30 Compiler, Assembler and Linker
- Highly optimized assembly code that uses DSP instructions and advanced addressing modes
- Comprehensive API that provides parametric control of the Noise Suppression engine
- Noise reduction level can be controlled from 0 dB to 44 dB
- Audio bandwidth of 0 kHz to 4 kHz at an 8 kHz sampling rate
- Library also includes:
  - Several sample .wav files that incorporate different types of noise components
  - User’s Guide
  - Sample demonstration application with complete source code

1.3 HOST SYSTEM REQUIREMENTS

The dsPIC DSC Noise Suppression Library requires a PC-compatible host system with these minimum characteristics:

- 1 GHz or higher processor
- HTML browser
- 16 MB RAM
- 40 MB available hard drive space
Chapter 2. Installation

This chapter describes the installation procedure for the dsPIC DSC Noise Suppression Library. To use the library, you must install it on your laptop or desktop PC. After installation, the library files can be included into the target application. Topics covered include:

- Installation Procedure
- Noise Suppression Library Files

2.1 INSTALLATION PROCEDURE

To install the library:

1. Double-click `NS setup.exe`. The License Agreement screen appears.
2. Review the License Agreement and click `I Agree` to continue. The Installation Destination dialog appears.
3. Specify the location (i.e., a directory) where the library should be installed, and then click `Install`.
4. Click `Close` to close the dialog. This completes the Noise Suppression Library installation.

The installation process creates the folder, `NS v6.0`, which contains the files described in 2.2 “Noise Suppression Library Files”.

2.2 NOISE SUPPRESSION LIBRARY FILES

The dsPIC DSC Noise Suppression Library CD creates a directory titled `NS v6.0`. This directory contains these folders:

- demo
- doc
- h
- lib
- wavefiles

2.2.1 demo Folder

This folder contains files that are required by the dsPIC DSC Noise Suppression Library Quick Start Demonstration. This folder contains these sub-folders:

- h
- libs
- src

Table 2-1 describes the files in these sub-folders.
TABLE 2-1: DEMONSTRATION FILES

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dsPIC33F NS demo.hex</td>
<td>Demo hex file for dsPIC33F.</td>
</tr>
<tr>
<td>dsPIC33E NS demo.hex</td>
<td>Demo hex file for dsPIC33E.</td>
</tr>
<tr>
<td>dsPIC33F NS demo.mcp</td>
<td>Demo MPLAB Project File for dsPIC33F.</td>
</tr>
<tr>
<td>dsPIC33E NS demo.mcp</td>
<td>Demo MPLAB Project File for dsPIC33E.</td>
</tr>
<tr>
<td>cleanup.bat</td>
<td>A batch file script to delete the intermediate build files.</td>
</tr>
<tr>
<td>h\dsPICDEM1_1Plus.h</td>
<td>C header file for the dsPICDEM™ 1.1 Plus development board routines.</td>
</tr>
<tr>
<td>h\MEB.h</td>
<td>C header file for the Multimedia Expansion Board (MEB) routines.</td>
</tr>
<tr>
<td>h\lcd.h</td>
<td>C header file defining interface to the LCD driver.</td>
</tr>
<tr>
<td>h\main.h</td>
<td>C header file for function and macros in main.c.</td>
</tr>
<tr>
<td>h\ns_api1.h</td>
<td>C header file defining the interface to the Noise Suppression Library.</td>
</tr>
<tr>
<td>h\Si3000CodecDrv.h</td>
<td>C header file defining the interface to the Si3000 Codec driver.</td>
</tr>
<tr>
<td>h\WM8731CodecDrv.h</td>
<td>C header file defining the interface to the WM8731 Codec driver.</td>
</tr>
<tr>
<td>libs\nslibv6_33F.a</td>
<td>The dsPIC DSC Noise Suppression Library archive file for dsPIC33F</td>
</tr>
<tr>
<td>libs\nslibv6_33E.a</td>
<td>The dsPIC DSC Noise Suppression Library archive file for dsPIC33E.</td>
</tr>
<tr>
<td>src\dsPICDEM1_1Plus.c</td>
<td>C source file containing routines for the dsPICDEM 1.1 Plus development board.</td>
</tr>
<tr>
<td>src\MEB.c</td>
<td>C source file containing routines for MEB.</td>
</tr>
<tr>
<td>src\lcd_strings.c</td>
<td>C source file for LCD display.</td>
</tr>
<tr>
<td>src\main.c</td>
<td>C source file containing the main speech processing routine.</td>
</tr>
<tr>
<td>src\Si3000CodecDrv.c</td>
<td>C source file containing the driver routines for Si3000 Codec.</td>
</tr>
<tr>
<td>src\WM8731CodecDRV.c</td>
<td>C source file containing the driver routines for WM8731 Codec.</td>
</tr>
<tr>
<td>src\lcd.s</td>
<td>Assembly routines for communicating with the LCD controller.</td>
</tr>
</tbody>
</table>

2.2.2 doc Folder

This folder contains the user’s guide for the dsPIC DSC Noise Suppression Library. To view this document, double-click the file name. The user’s guide can also be downloaded from the Microchip web site (www.microchip.com).

2.2.3 h Folder

This folder contains an include file for the Noise Suppression Library as shown in Table 2-2.

TABLE 2-2: INCLUDE FILE

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ns_api.h</td>
<td>Include file that contains the interface to the Noise Suppression Library. This file must be included in the application to use the Noise Suppression Library.</td>
</tr>
</tbody>
</table>
2.2.4  **lib Folder**

This folder contains the library archive files for the Noise Suppression Library as listed in **Table 2-3**. The archive names are suffixed with the names of the target device families, dsPIC33F or dsPIC33E.

**TABLE 2-3: LIBRARY FILES**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>nslibv6_33F.a</code></td>
<td>This is the Noise Suppression Library archive file for dsPIC33F. This file must be included in the application to use the Noise Suppression Library.</td>
</tr>
<tr>
<td><code>nslibv6_33E.a</code></td>
<td>This is the Noise Suppression Library archive file for dsPIC33E. This file must be included in the application to use the Noise Suppression Library.</td>
</tr>
</tbody>
</table>

2.2.5  **wavefiles Folder**

This folder contains the Wave files that can be used to evaluate the performance of the Noise Suppression Library when exposed to different noise environment. The Wave files can be played back on the PC using a media player with the repeat function ON to make the wave file run continuously. The descriptions of these files are provided in **Table 2-4**.

**TABLE 2-4: WAVE FILES**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Beverage_plant_babble.wav</code></td>
<td>Speech segment with unintelligible or meaningless (babble) noise.</td>
</tr>
<tr>
<td><code>Critical_white.wav</code></td>
<td>Speech segment with white noise.</td>
</tr>
<tr>
<td><code>Friends_70mph.wav</code></td>
<td>Speech segment with noise similar to that heard in a car cabin.</td>
</tr>
<tr>
<td><code>Late_morning_15mph.wav</code></td>
<td>Speech segment with noise similar to that heard in a car cabin.</td>
</tr>
<tr>
<td><code>Purple_tie_70mph.wav</code></td>
<td>Speech segment with noise similar to that heard in a car cabin.</td>
</tr>
<tr>
<td><code>Quench_tone.wav</code></td>
<td>Speech segment with single tone noise.</td>
</tr>
<tr>
<td><code>Taxi_white.wav</code></td>
<td>Speech segment with white noise.</td>
</tr>
<tr>
<td><code>Twilight_babble.wav</code></td>
<td>Speech segment with unintelligible or meaningless (babble) noise.</td>
</tr>
<tr>
<td><code>Unusual_15mph.wav</code></td>
<td>Speech segment with noise similar to that heard in a car cabin.</td>
</tr>
</tbody>
</table>
Chapter 3. Quick Start Demonstration

This chapter describes the dsPIC DSC Noise Suppression Library quick start demonstration for the dsPIC33F and dsPIC33E device families.

3.1 QUICK START DEMONSTRATION FOR dsPIC33F DEVICE FAMILY

The following topics are covered in this section:
- Demonstration Summary
- Demonstration Setup
- Demonstration Procedure
- Demonstration Code Description

3.1.1 Demonstration Summary

A dsPIC33F-based demonstration application program included with the dsPIC DSC Noise Suppression Library demonstrates the functionality of the library. In the demonstration setup (see Figure 3-1), a dsPICDEM™ 1.1 Plus development board is configured as a system that receives a noise-corrupted speech signal through its microphone input port, suppresses the noise in the sampled signal, and plays out the noise-suppressed signal through the speaker output port. The on-board Si3000 codec is used as the microphone and speaker interface.

A PC is used to drive noise-corrupted speech signals through an audio cable from the PC’s Speaker Out port to J16 (MIC IN) on the dsPICDEM 1.1 Plus development board. A headset or speaker is connected to J17 (SPKR OUT) on the dsPICDEM 1.1 Plus development board.

FIGURE 3-1: SETUP FOR NOISE SUPPRESSION DEMO

PC or Laptop running Noise Suppression demo

Audio Cable

Noisy Audio Input Signal

Noise-Suppressed Audio Output Signal
You can use the .wav files provided with the demo (in the wavefiles folder of the installation directory) as noise-corrupted speech signals, or you can provide your own signals. The noise-corrupted input signal is captured by the on-board Si3000 voice band codec and the Data Converter Interface (DCI) module of the dsPIC DSC device. The dsPIC DSC device then plays out the processed (noise-suppressed) signal through the device’s DCI module and the on-board Si3000 codec.

When started, the program initializes with noise suppression turned OFF, indicated by LED1 turned OFF and OFF being written to the LCD screen. With noise suppression OFF, the signal heard in the headset contains noticeable noise.

The noise suppression is enabled by pressing the switch, SW1. LED1 is now turned ON and ON is written to the LCD. The speech signal heard on the headset becomes relatively noise-free compared to the original signal. Use switches, SW2 and SW3, to control the noise suppression level. Note that increasing the noise suppression level also increases the overall attenuation of the signal.

Turn on the Repeat function in your PC’s media player, to allow the .wav file to run continuously. Observe when the signal is noisy and when it is noise suppressed. Repeat the process with several .wav files.

### 3.1.2 Demonstration Setup

The demonstration application is intended to run on a dsPICDEM 1.1 Plus development board (not included with the software license).

Use the procedures outlined in the following sections to set up the demonstration.

#### 3.1.2.1 CONFIGURE dsPICDEM 1.1 PLUS DEVELOPMENT BOARD

Before applying the power, you need to configure the board:

1. Set the jumper J9 (adjacent to the oscillator socket) to the **SLAVE** position. This setting allows the on-board Si3000 codec chip to function as a serial clock Slave.
2. Connect the audio cable between the Speaker Out port on the PC and the ‘Microphone’ jack (J16) on the dsPICDEM 1.1 Plus development board.
3. Connect the headset or speaker to the ‘SPKR OUT’ jack (J17).
4. Connect the MPLAB ICD 3 between the PC (USB cable) and dsPICDEM 1.1 Plus development board (RJ-11 phone cable).
5. Connect the 9V power supply to power-up the dsPICDEM 1.1 Plus development board.

---

**Note:** Some media players insert a break before each repeat of the .wav file. If you want to avoid this, a sound editor program, such as Audacity, can provide for continuous looping. Audacity, which is a free, cross-platform sound editor, is available from [http://audacity.sourceforge.net/](http://audacity.sourceforge.net/).

**Note:** The MPLAB® Real ICE™ In-Circuit Emulator can be used instead of MPLAB ICD 3.
3.1.2.2 PROGRAMMING THE dsPIC DSC DEVICE

Use the following process to load the noise suppression demonstration into the dsPIC DSC device on the dsPICDEM 1.1 Plus development board.

1. On your PC, launch MPLAB IDE and open the dsPIC33F NS demo.mcp project that is located in the demo folder. For more information on using MPLAB IDE, refer to the “MPLAB® IDE User’s Guide” (DS51025).

2. Import the project hex file (File > Import > dsPIC33F NS demo.hex).

3. Select Programmer > Connect to link the MPLAB ICD 3 to the dsPIC DSC target device. The Output window confirms that the MPLAB ICD 3 is ready.

4. Select Programmer > Program. The Output window displays the download process and indicates that the programming has succeeded.

5. When the program is loaded, disconnect the MPLAB ICD 3 from the board (remove the phone cable from the MPLAB ICD 3 connector).
3.1.3 Demonstration Procedure

With the demonstration application programmed into the device, the demonstration is ready to run. You can use the provided .wav files, which are located in the wavefiles folder of the installation directory as noise-corrupted speech signals, or you can provide your own signals. The noise-corrupted input signal is sampled through the on-board Si3000 voice band codec and the DCI module of the dsPIC DSC device. The dsPIC DSC device then plays the processed (noise-suppressed) signal through the DCI module of the device and the on-board Si3000 codec.

The demonstration application relays the state of operation through the LED and the LCD. While the application is loading and initializing the on-chip and off-chip peripherals, a boot screen appears, which then switches automatically to the run-time screen as illustrated in Figure 3-3).

FIGURE 3-3: DEMONSTRATION RUN-TIME LCD

The run-time screen displays the following:
1. The name of the algorithm.
2. SW1 is used to turn the noise suppression ON and OFF. SW4 is used to reinitialize the Noise Suppression algorithm.
3. The current state of the algorithm (OFF) and the selected noise reduction level.
4. A volume unit (VU) meter showing the input level. The bands show an acceptable input range. The * indicates that noise suppression has interpreted the frame as speech. The word CLIPPED is displayed when the input signal is too large.

When started, the program initializes with noise suppression turned OFF, indicated by LED1 being turned OFF and OFF displayed on the LCD. With noise suppression OFF, the signal heard in the headset contains noticeable noise.

The noise suppression is enabled by pressing SW1. LED1 is now turned ON. ON is displayed on the LCD and the speech signal heard on the headset becomes relatively noise-free compared to the original signal.

Turn ON the Repeat function in your PC’s media player, to allow the .wav file to run continuously. Observe when the signal is noisy and when it is noise suppressed. To experiment with different types and levels of noise, play several of the .wav files provided in the wavefiles folder.

The amount of noise reduction can be reduced in 1 dB steps (down to 0 dB) by pressing SW2. The amount of noise reduction can be increased in 1 dB steps (up to 44 dB) by pressing SW3. The noise suppression can be reinitialized by pressing SW4.
3.1.4 Demonstration Code Description

The demonstration code runs on a dsPIC33F device, using the Primary Oscillator as the clock source with the PLL configured for 40 MIPS operation.

The file, main.c, contains the main function for the demonstration application. This file allocates all of the variables and arrays in data memory that are needed for DCI data buffering, as well as the blocks of data memory that need to be allocated for the Noise Suppression Library functions.

The main function calls the NS_init() function from the Noise Suppression Library, which initializes the Noise Suppression algorithm to its default state.

The main function also calls the Si3000CodecInit() function to initialize the DCI module, the Si3000 codec and the DCI interrupt. The DCI module acts as a Master and drives the serial clock and frame synchronization lines. The Si3000 codec acts as a Slave. The DCI module is set for the multi-channel Frame Sync Operating mode, with 16-bit data words and 16 data words or time slots per frame. Only one transmit slot and one receive slot are used in this demonstration.

Subsequently, the Si3000CodecStart() function is used to initialize the Si3000 codec. The codec is reset, by connecting the RF6 pin of the dsPIC DSC device to the Reset pin of the Si3000, holding the port bit RF6 low for 100 cycles and then bringing it high. The codec is configured for a sample rate of 8 kHz. The Microphone Gain is set to 10 dB and the Receive Gain is set to 0 dB. Both speakers are set to active and the Transmit Gain is set to 0 dB. The Analog Attenuation parameter is set to 0 dB. After initializing all the Si3000 control registers, a delay is introduced for calibration of the Si3000 to occur. Finally, the DCI interrupt is enabled.

The codec driver is polled for a full frame of data. When the codec driver indicates a full frame of data is available, the contents of the codec data buffers are copied into the signalIn array and the NS_apply function from the Noise Suppression Library is called with signalIn as the input data frame. The signalIn data buffer, which is also the output of the NS_apply function after it has been executed, is played out on the speaker output of the headset.

The output on the LCD is made possible by initialization of the Serial Peripheral Interface (SPI) module in the InitSPI function, and LCD driver functions and LCD string definitions present in the lcd.s and lcd_strings.c files, respectively.

To toggle the noise suppression ON and OFF, external interrupts for SW1 are enabled. In the main loop, the value of applyNS is read and passed to NS_apply as the enable flag. If applyNS is '0', the Noise Suppression Library is still called, but the input/output buffer is not changed. This enables the Noise Suppression Library to maintain adaptation to changes in noise, even though it is not enabled.
3.2 QUICK START DEMONSTRATION FOR dsPIC33E DEVICE FAMILY

The following topics are covered in this section:
- Demonstration Summary
- Demonstration Setup
- Demonstration Procedure
- Demonstration Code Description

3.2.1 Demonstration Summary

A demonstration application program created specifically for the dsPIC33E family of devices is included with the dsPIC DSC Noise Suppression Library. In the demonstration setup (see Figure 3-4), a Multimedia Expansion Board (MEB) in conjunction with a dsPIC33E USB Starter Kit is configured as a system that receives a noise-corrupted speech signal through its microphone input port, suppresses the noise in the sampled signal, and outputs the noise-suppressed signal through the speaker output port. The on-board WM8731 codec is used as the microphone and speaker interface.

A PC is used to drive noise-corrupted speech signals through an audio cable from the PC’s Speaker Out port to the microphone input of the MEB. A headset or speaker is connected to the speaker output of the MEB.

FIGURE 3-4: SETUP FOR NOISE SUPPRESSION DEMO

You can use the .wav files provided with the demo (in the wavefiles folder of the installation directory) as noise-corrupted speech signals, or you can provide your own signals. The noise-corrupted input signal is captured by the on-board WM8731 voice audio codec and the DCI module of the dsPIC DSC device. The dsPIC DSC device then outputs the processed (noise-suppressed) signal through the device’s DCI module and the on-board WM8731 codec.

When started, the program initializes with noise suppression turned OFF, indicated by LED3 being turned OFF on the dsPIC33E USB Starter Kit. With noise suppression OFF, the signal heard in the headset contains noticeable noise.
The noise suppression is enabled by pressing the switch SW1 on the dsPIC33E USB Starter Kit. LED3 is now turned ON and the speech signal heard on the headset becomes relatively noise-free compared to the original signal. Use switches SW2 and SW3 to control the noise suppression level. Note that increasing the noise suppression level also increases the overall attenuation of the signal.

Turn ON the Repeat function in your PC’s media player to allow the .wav file to run continuously. Then, observe when the signal is noisy and when it is noise suppressed. Repeat the process with several .wav files.

3.2.2 Demonstration Setup

The demonstration application is intended to run on an MEB and dsPIC33E USB Starter Kit (not included with the software). Use the procedures outlined in the following sections to set up the demonstration.

3.2.2.1 CONFIGURE MEB AND dsPIC33E USB STARTER KIT

Before applying power, you need to configure the board:
1. Insert a dsPIC33E USB Starter Kit into the starter kit connector on the MEB.
2. Connect the audio cable between the Speaker Out port on the PC and the microphone jack (J7) on the MEB.
3. Connect the headphone jack (J8) of the MEB.
4. Connect the dsPIC33E USB Starter Kit to a PC using the USB A-to-Mini B cable provided with the Starter Kit.

3.2.2.2 PROGRAM THE dsPIC DSC DEVICE

Use this process to load the noise suppression demo into the dsPIC DSC device:
1. On your PC, launch MPLAB IDE and open the dsPIC33E NS demo.mcp project located in the demo folder.
   For more information on using MPLAB IDE, refer to “MPLAB® IDE User’s Guide” (DS51025).
2. Import the project hex file by selecting File > Import > dsPIC33E NS demo.hex.
3. Select Starter Kit on Board as the Programmer, and then select Programmer > Connect to link to the dsPIC DSC target device. The Output window confirms that the target device is ready.
4. Select Programmer > Program. The Output window displays the download process and indicates that the programming has succeeded.

Note: Some media players insert a break before each repeat of the .wav file. If you want to avoid this, a sound editor program, such as Audacity, can provide for continuous looping. Audacity, which is a free, cross-platform sound editor, is available from http://audacity.sourceforge.net/.

Note: After programming, unplug and reconnect the USB cable to the Starter Kit, to ensure that the WM8731 audio codec can be reconfigured.
3.2.3 Demonstration Procedure

With the demo application programmed into the device, the demonstration is ready to run. You can use the provided .wav files, which are located in the wavefiles folder of the installation directory as noise-corrupted speech signals, or you can provide your own signals. The noise-corrupted input signal is sampled through the on-board WM8731 voice band codec and the DCI module of the dsPIC DSC device. The dsPIC DSC device then plays out the processed (noise-suppressed) signal through the device’s DCI module and the on-board WM8731 codec.

When started, the program initializes with noise suppression turned OFF, indicated by LED3 turned OFF on the dsPIC33E USB Starter Kit. With noise suppression OFF, the signal heard in the headset contains noticeable noise.

The noise suppression is enabled by pressing switch SW1 on the dsPIC33E USB Starter Kit. LED3 is now turned ON. The speech signal heard on the headset becomes relatively noise-free compared to the original signal.

Turn on the Repeat function in your PC’s media player to allow the .wav file to run continuously. Observe when the signal is noisy and when it is noise suppressed. To experiment with different types and levels of noise, play several of the .wav files provided in the wavefiles folder.

The amount of noise reduction can be reduced in 1 dB steps (down to 0 dB) by pressing SW2 for a few seconds. The amount of noise reduction can be increased in 1 dB steps (up to 44 dB) by pressing SW3 for a few seconds.

The noise suppression can be reinitialized by pressing switch S1 on the LCD side of the MEB.

3.2.4 Demonstration Code Description

The demonstration code runs on a dsPIC33E device, using the Primary Oscillator as the clock source with the PLL configured for 40 MIPS operation.

The file, main.c, contains the main function for the demonstration application. This file (main.c) allocates all of the variables and arrays in data memory that are needed for DCI data buffering, as well as the blocks of data memory that need to be allocated for the Noise Suppression Library functions.

The main function calls the NS_init() function from the Noise Suppression Library, which initializes the Noise Suppression algorithm to its default state.

The main function also calls the WM8731Init() function to initialize the DCI module, the WM8731 codec, and the DCI interrupt. The WM8731 codec acts as a Master and drives the serial clock and frame synchronization lines. The DCI module is set for the multi-channel Frame Sync Operating mode, with 16-bit data words and two data words or time slots per frame, that is, two transmit slots and two receive slots are used in this demonstration.

Subsequently, the WM8731Start() function is used to enable the DCI module and I²C module. The codec is configured for a sample rate of 8 kHz.

The codec driver is polled for a full frame of data. When the codec driver indicates a full frame of data is available, the contents of the codec data buffers are copied into the signalIn array and the NS_apply function from the Noise Suppression Library is called with signalIn as the input data frame. The signalIn data buffer, which is also the output of the NS_apply function after it has been executed, is played out on the speaker output of the headset.

In the main loop, the value of applyNS is read and passed to NS_apply as the enable flag. If applyNS is ‘0’, the Noise Suppression Library is still called, but the input/output buffer is not changed. This enables the Noise Suppression Library to maintain adaptation to changes in noise, even though it is not enabled.
Chapter 4. Application Programming Interface (API)

This chapter describes the Application Programming Interface (API) available in the dsPIC DSC Noise Suppression Library. The following topics are covered in this chapter:

- Adding the Noise Suppression Library to an Application
- Library Usage
- Resource Requirements
- Noise Suppression Library API Functions
- Application Tips

4.1 ADDING THE NOISE SUPPRESSION LIBRARY TO AN APPLICATION

To use the Noise Suppression Library in an application, the library archive must be added to the application project workspace and the `ns_api.h` header file must be included in the application code. This file can be copied from the `h` folder (located in the installation directory) to the application project folder.

Use the following procedure to add the library to the application:

1. In the application MPLAB workspace, right-click Library Files in the Project Window and select Add files.
2. Browse to the location of either the `nslibv6_33F.a` file or the `nslibv6_33E.a` file, both of which are available in the `libs` folder in the installation directory.
3. Select the desired file, and then click Open.
4. The library is added to the application. Verify that the library archive is shown in the MPLAB project.
4.2 LIBRARY USAGE

The Noise Suppression algorithm has been designed to be usable in a re-entrant environment. This feature enables the algorithm to process many independent channels of audio, with each channel having its own setting and parameters.

There are at least five coding steps that need to be performed to enable use of the Noise Suppression Library:

1. Allocate the memory for the input/output data array. The array size should be \texttt{NS\_FRAME}. The array should be placed in X memory and should be aligned to a 4-byte boundary.

2. Allocate the memory for the Noise Suppression algorithm state holder: This memory is an integer array in X memory aligned at an address boundary of 4 bytes. The \texttt{NS\_XSTATE\_MEM\_SIZE\_INT} macro specifies the size of this array. Every audio channel to be processed requires its own state holder.

3. Allocate the memory for the Noise Suppression algorithm X and Y scratch memories: The X scratch is an integer array in X memory aligned at an address boundary of 4 bytes. This Y scratch memory is an integer array in Y memory aligned at an address boundary of 512 bytes. Multiple audio channels can share the scratch memories.

4. Initialize the Noise Suppression algorithm state for each audio channel: Use the \texttt{NS\_init()} function for initializing the noise suppression state for each audio channel.

5. Apply the Noise Suppression algorithm to an audio frame: Use the \texttt{NS\_apply()} function to perform noise suppression on an audio frame. If a frame is not required to be processed by the Noise Suppression algorithm, the function should still be called with the enable parameter set to \texttt{NS\_FALSE}. This allows the Noise Suppression algorithm to continue adapting to the noise in the audio frame. The audio frame stays unaffected.

Example 4-1 provides a code example showing these five steps.

\textbf{Note:} In some dsPIC33E devices, the Y memory is located in the Extended Data Space (EDS). In such cases, the Y scratch memory array must be tagged with the \texttt{__eds__} keyword and assigned an \texttt{eds} attribute.
EXAMPLE 4-1: LIBRARY USAGE EXAMPLE

```c
/* Data array */
int input1[NS_FRAME]_XBSS(4); /* Step 1 */
int input2[NS_FRAME]_XBSS(4); /* Step 1 */

/* Channel 1 memory structures */
int nsStateMemX1 [NS_XSTATE_MEM_SIZE_INT] _XBSS(4); /* Step 2 */

/* Channel 2 memory structures */
int nsStateMemX2 [NS_XSTATE_MEM_SIZE_INT] _XBSS(4); /* Step 2 */

/* Each instance can share the same X and Y scratch memory. */
int nsScratchX [NS_XSCRATCH_MEM_SIZE_INT]_XBSS(4); /* Step 3 */
int nsScratchY [NS_YSCRATCH_MEM_SIZE_INT]_YBSS(512); /* Step 3 */

void main()
{
    NS_init(nsStateMemX1, nsScratchX, nsScratchY); /* Step 4 */
    NS_init(nsStateMemX2, nsScratchX, nsScratchY); /* Step 4 */
    while(1)
    {
        /* input1 and input2 are two different audio streams */
        NS_apply(nsStateMemX1, input1, NS_TRUE); /* Step 5 */
        NS_apply(nsStateMemX2, input2, NS_TRUE); /* Step 5 */
    }
}
```
4.3 RESOURCE REQUIREMENTS

The Noise Suppression Library requires the following computational resources while running on the dsPIC DSC device.

**TABLE 4-1: PROGRAM MEMORY USAGE FOR dsPIC33F**

<table>
<thead>
<tr>
<th>Type</th>
<th>Size (bytes)</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code in Program Memory</td>
<td>6675 (dsPIC30F/dsPIC33F)</td>
<td>.libns</td>
</tr>
<tr>
<td></td>
<td>6414 (dsPIC33E)</td>
<td></td>
</tr>
<tr>
<td>Tables in Program Memory</td>
<td>1383 (dsPIC30F/dsPIC33F)</td>
<td>.const</td>
</tr>
<tr>
<td></td>
<td>0 (dsPIC33E)</td>
<td></td>
</tr>
<tr>
<td>Total Program Memory</td>
<td>8058 (dsPIC30F/dsPIC33F)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6414 (dsPIC33E)</td>
<td>—</td>
</tr>
</tbody>
</table>

**TABLE 4-2: DATA MEMORY USAGE**

<table>
<thead>
<tr>
<th>Function</th>
<th>Size (bytes)</th>
<th>Alignment</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>nsStateMemX</td>
<td>768</td>
<td>4</td>
<td>X data memory</td>
</tr>
<tr>
<td>scratchMemX</td>
<td>100</td>
<td>4</td>
<td>X data memory</td>
</tr>
<tr>
<td>scratchMemY</td>
<td>256</td>
<td>512</td>
<td>Y data memory</td>
</tr>
<tr>
<td>signalIn</td>
<td>160</td>
<td>4</td>
<td>X data memory</td>
</tr>
<tr>
<td>Tables in Data Memory</td>
<td>0 (dsPIC30F/dsPIC33F)</td>
<td>4</td>
<td>X data memory</td>
</tr>
<tr>
<td>922 (dsPIC33E)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Data Memory</td>
<td>1284 (dsPIC30F/dsPIC33F)</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>2206 (dsPIC33E)</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

**TABLE 4-3: ESTIMATED DYNAMIC USAGE**

<table>
<thead>
<tr>
<th>Section</th>
<th>Size (bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heap</td>
<td>0</td>
</tr>
<tr>
<td>Stack</td>
<td>&lt; 300</td>
</tr>
</tbody>
</table>

**TABLE 4-4: COMPUTATIONAL SPEED**

<table>
<thead>
<tr>
<th>Function</th>
<th>MIPS</th>
<th>Typical Call Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>NS_init()</td>
<td>&lt; 0.5</td>
<td>Once</td>
</tr>
<tr>
<td>NS_apply()</td>
<td>3.6</td>
<td>10 ms</td>
</tr>
<tr>
<td>All other functions</td>
<td>Minimal</td>
<td>As required</td>
</tr>
</tbody>
</table>

**4.3.1 Data Format**

The input data to the Noise Suppression Library can be 10-bit, 12-bit or 16-bit linear Pulse Code Modulation (PCM) data. The Noise Suppression algorithm automatically adjusts for the data format used.
4.4 NOISE SUPPRESSION LIBRARY API FUNCTIONS

This section lists and describes the API functions that are available in the dsPIC DSC Noise Suppression Library. The functions are listed below followed by their individual detailed descriptions.

- NS_init
- NS_relocateXScratchMem
- NS_relocateYScratchMem
- NS_apply
- NS_setNoiseReduction
- NS_getNoiseReduction
- NS_setVadHangover
- NS_getVadHangover
- NS_setNoiseFactor
- NS_getNoiseFactor
- NS_setNoiseEstimationFactor
- NS_getNoiseEstimationFactor
- NS_setNoiseFloor
- NS_getNoiseFloor
- NS_getIsSpeech
- NS_estimateSNR
- NS_TRUE
- NS_FALSE
- NS_SLOW
- NS_NORMAL
- NS_FAST
- NS_FRAME
- NS_XSTATE_MEM_SIZE_INT
- NS_XSCRATCH_MEM_SIZE_INT
- NS_YSCRATCH_MEM_SIZE_INT
- NS_NRLEVELDEFAULT
- NS_VADHANGOVERDEFAULT
- NS_NOISEFLOORDEFAULT
- NS_POWERFACTORDEFAULT
**NS_init**

**Description**

Initializes the Noise Suppression algorithm.

**Include**

ns_api.h

**Prototype**

```c
void NS_init(int* ptrStateX, int* xScratchMem, int* yScratchMem);
```

**Arguments**

- `ptrStateX` a pointer to the state memory for this instance of Noise Suppression
- `xScratchMem` a pointer to an area of scratch memory in X RAM used by the Noise Suppression algorithm
- `yScratchMem` a pointer to an area of scratch memory in Y RAM used by the Noise Suppression algorithm

**Return Value**

None.

**Remarks**

None.

**Code Example**

```c
int nsStateMemX [NS_XSTATE_MEM_SIZE_INT]_XBSS(4);
int nsScratchX [NS_XSCRATCH_MEM_SIZE_INT]_XBSS(4);
int nsScratchY [NS_YSCRATCH_MEM_SIZE_INT]_YBSS(512);
.
.
.
NS_init(nsStateMemX, nsScratchX, nsScratchY);
```
NS_relocateXScratchMem

Description
Changes the X memory scratch buffer used by the Noise Suppression algorithm.

Include
ns_api.h

Prototype
void NS_relocateXScratchMem(int* ptrStateX, int* xScratchMem);

Arguments
ptrStateX a pointer to the state memory for this instance of Noise Suppression
xScratchMem a pointer to the new Y scratch memory to be used by the Noise Suppression algorithm

Return Value
None.

Remarks
After relocating the X scratch memory, the older scratch memory is not used by the Noise Suppression Library.

Code Example
    int nsStateMemX [NS_XSTATE_MEM_SIZE_INT] _XBSS(4);
    int nsScratchX [NS_XSCRATCH_MEM_SIZE_INT] _XBSS(4);
    int nsScratchX2 [NS_XSCRATCH_MEM_SIZE_INT] _XBSS(4);
    int nsScratchY [NS_YSCRATCH_MEM_SIZE_INT] _YBSS(512);
    ...
    ...
    NS_init(nsStateMemX, nsScratchX, nsScratchY);
    Noise Suppression algorithm is using nsScratchX for its scratch memory.
    ...
    ...
    NS_relocateXScratchMem(nsStateMemX, nsScratchX2);
    Noise Suppression algorithm is now using nsScratchX2 for its scratch memory.
**NS_relocateYScratchMem**

**Description**
Changes the Y memory scratch buffer used by the Noise Suppression algorithm.

**Include**
ns_api.h

**Prototype**
```c
void NS_relocateYScratchMem(int* ptrStateX, int* yScratchMem);
```

**Arguments**
- `ptrStateX` a pointer to the state memory for this instance of Noise Suppression
- `yScratchMem` a pointer to the new Y scratch memory to be used by the Noise Suppression algorithm

**Return Value**
None.

**Remarks**
After relocating the Y scratch memory, the older scratch memory is not used by the Noise Suppression Library.

**Code Example**
```c
int nsStateMemX [NS_XSTATE_MEM_SIZE_INT] _XBSS(4);
int nsScratchX [NS_XSCRATCH_MEM_SIZE_INT] _XBSS(4);
int nsScratchY [NS_YSCRATCH_MEM_SIZE_INT] _YBSS(512);
int nsScratchY2 [NS_YSCRATCH_MEM_SIZE_INT] _YBSS(512);
.
.
NS_init(nsStateMemX, nsScratchX, nsScratchY);
Noise Suppression algorithm is using nsScratchY for its Y memory scratch buffer.
.
.
NS_relocateYScratchMem(nsStateMemX, nsScratchY2);
Noise Suppression algorithm is now using nsScratchY2 for its scratch memory.
```
NS_apply

Description
Applies noise reduction to the current frame of data.

Include
ns_api.h

Prototype
void NS_apply(int* ptrStateX, int* signalIn, int enable);

Arguments
ptrStateX   a pointer to the state memory for this instance of Noise Suppression
SignalIn   a pointer to the input/output buffer of size NS_FRAME
Enable    a flag to indicate if Noise Suppression is required for this buffer (NS_TRUE/NS_FALSE)

Return Value
None.

Remarks
The Noise Suppression processes the data “in-place”, meaning that the output is passed back in the input buffer. Setting Enable to NS_FALSE returns an unprocessed buffer of data, but the Noise Suppression algorithm still adapts on the data.

Code Example
int nsStateMemX [NS_XSTATE_MEM_SIZE_INT] _XBSS(4);
int nsScratchY [NS_YSCRATCH_MEM_SIZE_INT] _YBSS(512);
int nsScratchX [NS_XSCRATCH_MEM_SIZE_INT] _XBSS(4);
;
;
;
NS_init(nsStateMemX, nsScratchX, nsScratchY);
;
;
;
NS_apply(nsStateMemX, input, NS_TRUE);
**NS_setNoiseReduction**

**Description**
Sets the noise reduction level (in dB).

**Include**
ns_api.h

**Prototype**
void NS_setNoiseReduction(int* ptrStateX, int leveldB);

**Arguments**
- ptrStateX a pointer to the state memory for this instance of Noise Suppression
- leveldB an integer value between 0 and 44 representing the desired noise reduction level in dB

**Return Value**
None.

**Remarks**
The desired noise reduction level is measured using white noise. Other types of noise result in different amounts of noise reduction.

**Code Example**
```
NS_setNoiseReduction(nsStateMemX, 18);
```
Sets the desired noise reduction level to 18 dB for the instance of the algorithm nsStateMemX.
NS_getNoiseReduction

Description
Returns the current noise reduction value (in dB).

Include
ns_api.h

Prototype
int NS_getNoiseReduction(int* ptrStateX);

Arguments
ptrStateX   a pointer to the state memory for this instance of Noise Suppression

Return Value
The current desired noise reduction level in dB as an integer for the instance of the algorithm nsStateMemX.

Remarks
None.

Code Example
    int nrLevel;
    nrLevel = NS_getNoiseReduction(nsStateMemX);
    nrLevel contains the desired noise reduction level for the instance of the algorithm nsStateMemX.
NS_setVadHangover

Description
Sets the VAD hangover value.

Include
ns_api.h

Prototype
void NS_setVadHangover(int* ptrStateX, int value);

Arguments
ptrStateX a pointer to the state memory for this instance of Noise Suppression
value an integer value from 1 to 100 representing the desired VAD hangover

Return Value
None.

Remarks
The VAD hangover is used to adjust the hysteresis around the VAD. A larger value keeps the VAD active longer. Setting VAD hangover to '1' disables the hysteresis. Selecting a value outside the permitted range (1 to 100) results in the previous setting being retained.

Code Example
    NS_setVadHangover(nsStateMemX, 10);
Sets the desired VAD hangover to 10 frames (representing 100 ms of data) for the instance of the algorithm nsStateMemX.
**NS_getVadHangover**

**Description**
Returns the current VAD hangover.

**Include**
ns_api.h

**Prototype**
```c
int NS_getVadHangover(int* ptrStateX);
```

**Arguments**
ptrStateX      a pointer to the state memory for this instance of Noise Suppression

**Return Value**
VAD hangover value.

**Remarks**
None.

**Code Example**
```c
int vadHangover;
vadHangover = NS_getVadHangover(nsStateMemX);
```

vadHangover contains the VAD hangover value set for the instance of the algorithm nsStateMemX.
**NS_setNoiseFactor**

**Description**
Sets the noise factor.

**Include**
ns_api.h

**Prototype**
void NS_setNoiseFactor(int* ptrStateX, int value);

**Arguments**
- **ptrStateX**: a pointer to the state memory for this instance of Noise Suppression
- **value**: an integer value between 1 and 15 representing the desired noise factor

**Return Value**
None.

**Remarks**
Sets the noise factor used by the VAD to determine speech from noise. A higher value will flag more frames of data as noise. Legal values are in the range 1 to 15 inclusive.

**Code Example**
```
    NS_setNoiseFactor(nsStateMemX, 3);
```
Sets the noise factor to 3 for the instance of the algorithm `nsStateMemX`.
NS_getNoiseFactor

Description
Returns the current noise factor.

Include
ns_api.h

Prototype
int NS_getNoiseFactor(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of Noise Suppression

Return Value
Noise factor.

Remarks
None.

Code Example
    int noiseFactor;
    noiseFactor = NS_getNoiseFactor(nsStateMemX);
noiseFactor contains the noise factor value set for the instance of the algorithm
nsStateMemX.
NS_setNoiseEstimationFactor

Description
Sets the noise estimation factor.

Include
ns_api.h

Prototype
void NS_setNoiseEstimationFactor(int* ptrStateX, int level);

Arguments
ptrStateX  a pointer to the state memory for this instance of Noise Suppression
level     either NS_SLOW, NS_NORMAL or NS_FAST

Return Value
None.

Remarks
This factor determines how quickly the Noise Suppression algorithm updates its noise estimate after detecting a noise frame.

Code Example
    NS_setNoiseEstimationFactor(nsStateMemX, NS_NORMAL);
Sets the noise factor to normal speed for the instance of the algorithm nsStateMemX.
NS_getNoiseEstimationFactor

Description
Returns the current noise estimation factor.

Include
ns_api.h

Prototype
int NS_getNoiseEstimationFactor(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of Noise Suppression

Return Value
Noise estimation factor.

Remarks
None.

Code Example
    int noiseEstFactor;
    noiseEstFactor = NS_getNoiseEstimationFactor(nsStateMemX);
noiseEstFactor contains the noise estimation factor value set for the instance of the
algorithm nsStateMemX, either NS_SLOW, NS_NORMAL, or NS_FAST.
NS_setNoiseFloor

Description
Sets the noise floor, below which the Noise Suppression algorithm will not update.

Include
ns_api.h

Prototype
void NS_setNoiseFloor(int* ptrStateX, long floor);

Arguments
ptrStateX    a pointer to the state memory for this instance of Noise Suppression
floor       a long integer value between representing the background noise
            level, below which the Noise Suppression algorithm will not update

Return Value
None.

Remarks
System noise represents the noise contributed by the application hardware. It does not include the noise contained in the input signal. For example, if the noise generated by hardware is experimentally determined to be -60 dBm0 or -66 dBov, the representative hexadecimal value for the noise floor is computed as shown in Equation 4-1.

EQUATION 4-1: NOISE FLOOR CALCULATION EXAMPLE

\[
10 \, ^{\text{66}}_{10} \times 80 \times (2^{32} - 1) \approx 86307 = 0x15123
\]

Note: The number in bold type represents the value under consideration.

In this case, setting the noise floor to 0x15123, which is supplied to the function, causes the Noise Suppression algorithm to stop adapting when the noise energy is below -60 dBm0. To disable this feature, set the value to zero.

Code Example

```c
NS_setNoiseFloor(nsStateMemX, 0x1D1917);
```
Sets the noise floor to 0x1D1917 for the instance of the algorithm `nsStateMemX`.  

-66
NS_getNoiseFloor

Description
Returns the current noise floor.

Include
ns_api.h

Prototype
long NS_getNoiseFloor(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of Noise Suppression

Return Value
None.

Remarks
Returns the current noise floor value.

Code Example
    long noiseFloor;
    noiseFloor = NS_getNoiseFloor(nsStateMemX);
noiseFloor contains the noise floor value set for the instance of the algorithm
nsStateMemX.
NS_getIsSpeech

Description
Returns a flag indicating if the Noise Suppression algorithm thinks the current frame is speech or noise.

Include
ns_api.h

Prototype
int NS_getIsSpeech(int* ptrStateX);

Arguments
ptrStateX  a pointer to the state memory for this instance of Noise Suppression

Return Value
An integer flag of either NS_TRUE or NS_FALSE.

Remarks
This is an indication of the presence of speech in the input signal. This flag is effected by the VAD hangover, noise floor and power factor.

Code Example
```c
int speech;
    speech = NS_getIsSpeech(nsStateMemX);
```
speech is a flag representing whether the Noise Suppression algorithm thinks the current frame contains speech.
**NS_estimateSNR**

**Description**
Estimates the Signal-to-Noise Ratio (SNR).

**Include**
ns_api.h

**Prototype**
```
int NS_estimateSNR(int* preNS, int* postNS);
```

**Arguments**
- **preNS** a pointer to the buffer of data before the Noise Suppression algorithm has been applied
- **postNS** a pointer to the buffer of data after the Noise Suppression algorithm has been applied

**Return Value**
An estimate of the SNR.

**Remarks**
This is a crude estimate of the SNR of the current frame of data.

**Code Example**
```
int snr;
for (i = 0; i < NS_FRAME; i++)
{
    signalBefore[i] = signalIn[i];
}
NS_apply(nsStateMemX, nsScratchY, signalIn, NS_TRUE);
snr = NS_estimateSNR(signalBefore, SignalIn);
```

`snr` contains the estimate of the SNR.
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>NS_TRUE</td>
<td>Used to indicate true to the Noise Suppression algorithm.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NS_FALSE</td>
<td>Used to indicate false to the Noise Suppression algorithm.</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NS_SLOW</td>
<td>Used in conjunction with NS_setNoiseEstimationFactor and NS_getNoiseEstimationFactor, to adjust the speed of adaptation to noise.</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NS_NORMAL</td>
<td>Used in conjunction with NS_setNoiseEstimationFactor and NS_getNoiseEstimationFactor, to adjust the speed of adaptation to noise.</td>
<td>200</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>NS_FAST</td>
<td>Used in conjunction with <code>NS_setNoiseEstimationFactor</code> and <code>NS_getNoiseEstimationFactor</code>, to adjust the speed of adaptation to noise.</td>
<td>300</td>
</tr>
<tr>
<td>NS_FRAME</td>
<td>The size of the input buffer processed.</td>
<td>80</td>
</tr>
<tr>
<td>NS_XSTATE_MEM_SIZE_INT</td>
<td>Size in integers of the memory location required for the X-State memory.</td>
<td>383</td>
</tr>
<tr>
<td>NS_XSCRATCH_MEM_SIZE_INT</td>
<td>Size in integers of the memory location required for the X-Scratch memory.</td>
<td>50</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>NS_YSCRATCH_MEM_SIZE_INT</td>
<td>Size in integers of the memory location required for the Y-Scratch memory.</td>
<td>128</td>
</tr>
<tr>
<td>NS_NRLEVELDEFAULT</td>
<td>Value in dB for the default noise reduction.</td>
<td>15</td>
</tr>
<tr>
<td>NS_VADHANGOVERDEFAULT</td>
<td>Value of the default VAD Hangover.</td>
<td>6</td>
</tr>
<tr>
<td>NS_NOISEFLOORDEFAULT</td>
<td>Value of the default noise floor.</td>
<td>0x1D1917</td>
</tr>
<tr>
<td>NS_POWERFACTORDEFAULT</td>
<td>Default value for the noise power factor.</td>
<td>2</td>
</tr>
</tbody>
</table>
4.5 APPLICATION TIPS

Although the Noise Suppression algorithm makes a best effort to suppress the noise level in a signal, its performance can be optimized by proper selection of parameters. In general, experimentation with this library is encouraged.

A few tips for affecting the performance of the algorithm are as follows:

1. The optimum input signal levels for testing audio systems are generally considered to be between -10 dBm0 and -30 dBm0. If digital input speech levels have peaks that are up to three-fourths of full range, then good use is being made of the available precision; levels higher than this carry a risk of amplitude clipping.

2. Choose the noise reduction level range that best fits the application. A very high noise suppression level not only suppresses the noise, but also reduces the speech level to some extent.

3. The VAD Hangover can be used to adjust the rate at which the Noise Suppression algorithm adapts. Having a larger VAD Hangover increases the time the algorithm takes to adapt to changes in the noise level. A shorter VAD Hangover will allow the Noise Suppression algorithm to treat more input frames as noise frames, and therefore, adapt faster.

4. If the level of the noise compared to speech is high, you may want to increase the value of the Noise Factor.

5. The Noise Estimation Factor determines how quickly the Noise Suppression algorithm’s Noise Estimate is updated after a noise frame has been detected. You may consider setting this parameter to NS_SLOW when the noise environment is known to be more static in nature.

Independent of the noise contained in the speech signal, the application hardware, like all electrical circuits, generates a small amount of noise which is still there when the microphone is disconnected. The Noise Suppression algorithm should freeze adaptation in this case, so that when the microphone is reconnected it will carry on as if nothing has happened. However, if it is found that the noise suppression has diverged, then the default noise floor is too low. To counter this, use the NS_setNoiseFloor function to increase the noise floor (some trial and error may be needed).
## Index

### A
- Algorithm Overview .................................................. 11
- API .......................................................... 5, 25
- API Functions ........................................................... 29
  - NS_apply .......................................................... 33
  - NS_estimateSNR .................................................. 40, 45
  - NS_FALSE ......................................................... 46
  - NS_FAST ........................................................... 47
  - NS_FRAME ......................................................... 47
  - NS_getIsSpeech .................................................. 44
  - NS_getNoiseEstimationFactor .................. 41
  - NS_getNoiseFactor ............................................. 39
  - NS_getNoiseFloor .............................................. 43
  - NS_getNoiseReduction ......................................... 35
  - NS_getVadHangover ............................................. 37
  - NS_init .......................................................... 30
  - NS_NOISEFLOORDEFAULT .................................... 48
  - NS_NORMAL ...................................................... 46
  - NS_NRLEVELDEFAULT ........................................... 48
  - NS_POWERFACTORDEFAULT ..................................... 48
  - NS_relocateXScratchMem .................................... 31
  - NS_relocateYScratchMem .................................... 32
  - NS_setNoiseEstimationFactor .................. 40
  - NS_setNoiseFactor ............................................. 38
  - NS_setNoiseFloor .............................................. 42
  - NS_setNoiseReduction ......................................... 34
  - NS_setVadHangover ............................................. 36
  - NS_SLOW ........................................................... 46
  - NS_TRUE ......................................................... 46
  - NS_VADHANGOVERDEFAULT .................................... 48
  - NS_XSCRATCH_MEM_SIZE_INT ................................ 47
  - NS_XSTATE_MEM_SIZE_INT .................................... 47
  - NS_YSCRATCH_MEM_SIZE_INT ................................ 48

### C
- Customer Notification Service ................................. 8
- Customer Support .................................................. 8

### D
- Demonstration .......................................................... 18, 23
  - Board Configuration ........................................... 18, 23
  - Device Programming ............................................ 19, 23
  - Running the Demo ............................................. 20, 24
  - Setup ........................................................... 17, 22
- Documentation .......................................................... 6
  - Conventions ...................................................... 6
  - Layout ........................................................... 5

### F
- Fast Fourier Transform (FFT) ........................................... 11

### H
- Host System Requirements ........................................... 12

### I
- Installation .......................................................... 8
  - Installing the Library ........................................... 13
- Internet Address ................................................... 8

### L
- Library Files .......................................................... 13
  - demo Folder ..................................................... 13
  - doc Folder ...................................................... 14
  - h Folder ......................................................... 14
  - wavefiles Folder ............................................... 15

### M
- Microchip Internet Web Site ......................................... 8
- MPLAB IDE User’s Guide ........................................... 7

### R
- Resource Requirements .......................................................... 28
  - Computational Speed ........................................... 28
  - Data Format ...................................................... 28
  - Data Memory Usage ............................................. 28
  - Estimated Dynamic Memory Usage .................. 28
  - Program Memory Usage ........................................ 28

### V
- Voice Activity Detection (VAD) ......................................... 11

### W
- Warranty Registration ................................................... 7
- WWW Address .......................................................... 8
## World Wide Sales and Service

<table>
<thead>
<tr>
<th>AMERICAS</th>
<th>ASIA/PACIFIC</th>
<th>ASIA/PACIFIC</th>
<th>ASIA/PACIFIC</th>
<th>EUROPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate Office</td>
<td>Asia Pacific Office</td>
<td>India - Bangalore</td>
<td>India - New Delhi</td>
<td>Austria - Wels</td>
</tr>
<tr>
<td>2355 West Chandler Blvd.</td>
<td>Suites 3707-14, 37th Floor</td>
<td>Tel: 91-80-3090-4444</td>
<td>Tel: 91-11-4160-8631</td>
<td>Tel: 43-7242-2244-39</td>
</tr>
<tr>
<td>Chandler, AZ 85224-6199</td>
<td>Tower 6, The Gateway</td>
<td>Fax: 91-80-3090-4123</td>
<td>Fax: 91-11-4160-8632</td>
<td>Fax: 43-7242-2244-393</td>
</tr>
<tr>
<td>Tel: 480-792-7200</td>
<td>Harbour City, Kowloon</td>
<td></td>
<td></td>
<td>Denmark - Copenhagen</td>
</tr>
<tr>
<td>Fax: 480-792-7277</td>
<td>Hong Kong</td>
<td>Tel: 45-4450-2828</td>
<td>Tel: 45-4450-2829</td>
<td>Tel: 45-4450-2828</td>
</tr>
<tr>
<td>Technical Support:</td>
<td>Tel: 852-2401-1200</td>
<td>Fax: 91-20-2566-1512</td>
<td>Fax: 91-20-2566-1513</td>
<td>EUROPE</td>
</tr>
<tr>
<td><a href="http://www.microchip.com/support">http://www.microchip.com/support</a></td>
<td>Fax: 852-2401-3431</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Address:</td>
<td></td>
<td></td>
<td></td>
<td>Austria - Wels</td>
</tr>
<tr>
<td><a href="http://www.microchip.com">www.microchip.com</a></td>
<td></td>
<td></td>
<td></td>
<td>Tel: 43-7242-2244-39</td>
</tr>
<tr>
<td>Atlanta</td>
<td>China - Beijing</td>
<td>India - Pune</td>
<td>Korea - Daegu</td>
<td>Austria - Wels</td>
</tr>
<tr>
<td>Duluth, GA</td>
<td>Tel: 86-10-8569-7000</td>
<td>Tel: 91-20-2566-1512</td>
<td>Tel: 82-53-744-4301</td>
<td>Tel: 43-7242-2244-393</td>
</tr>
<tr>
<td>Tel: 678-957-9614</td>
<td>Fax: 86-10-8528-2104</td>
<td>Fax: 91-20-2566-1513</td>
<td>Fax: 82-53-744-4302</td>
<td></td>
</tr>
<tr>
<td>Fax: 678-957-1455</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boston</td>
<td>China - Chengdu</td>
<td>Japan - Yokohama</td>
<td>Korea - Seoul</td>
<td>Denmark - Copenhagen</td>
</tr>
<tr>
<td>Westborough, MA</td>
<td>Tel: 86-28-8665-5511</td>
<td>Tel: 81-45-471-6166</td>
<td>Tel: 82-2-554-7200</td>
<td>Tel: 45-4450-2828</td>
</tr>
<tr>
<td>Tel: 774-760-0087</td>
<td>Fax: 86-28-8665-7889</td>
<td>Fax: 81-45-471-6122</td>
<td>Fax: 82-2-558-5932</td>
<td>Fax: 45-4485-2829</td>
</tr>
<tr>
<td>Fax: 774-760-0088</td>
<td></td>
<td></td>
<td>or</td>
<td></td>
</tr>
<tr>
<td>Chicago</td>
<td>China - Chongqing</td>
<td>Korea - Penang</td>
<td>Malaysia - Kuala Lumpur</td>
<td>France - Paris</td>
</tr>
<tr>
<td>Itasca, IL</td>
<td>Tel: 86-23-8980-9588</td>
<td>Tel: 60-4-227-8870</td>
<td>Tel: 60-3-6201-9857</td>
<td>Tel: 33-1-69-53-63-20</td>
</tr>
<tr>
<td>Tel: 630-285-0071</td>
<td>Fax: 86-23-8900-9500</td>
<td>Fax: 60-4-227-4068</td>
<td>Fax: 60-3-6201-9859</td>
<td>Fax: 33-1-69-30-90-79</td>
</tr>
<tr>
<td>Fax: 630-285-0075</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cleveland</td>
<td>China - Hangzhou</td>
<td>Malaysia - Penang</td>
<td>Malaysia - Kuala Lumpur</td>
<td>Germany - Munich</td>
</tr>
<tr>
<td>Independence, OH</td>
<td>Tel: 86-571-2819-3180</td>
<td>Tel: 60-4-227-8870</td>
<td>Tel: 60-3-6201-9857</td>
<td>Tel: 49-89-627-144-0</td>
</tr>
<tr>
<td>Tel: 216-447-0464</td>
<td>Fax: 86-571-2819-3189</td>
<td>Fax: 60-4-227-4068</td>
<td>Fax: 60-3-6201-9859</td>
<td>Fax: 49-89-627-144-44</td>
</tr>
<tr>
<td>Fax: 216-447-0643</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dallas</td>
<td>China - Hong Kong SAR</td>
<td>Malaysia - Penang</td>
<td>Malaysia - Penang</td>
<td>Italy - Milan</td>
</tr>
<tr>
<td>Addison, TX</td>
<td>Tel: 852-2401-1200</td>
<td>Tel: 60-4-227-8870</td>
<td>Tel: 60-4-227-4068</td>
<td>Tel: 39-0331-742611</td>
</tr>
<tr>
<td>Tel: 972-818-7423</td>
<td>Fax: 852-2401-3431</td>
<td>Fax: 60-4-227-4068</td>
<td>Fax: 39-0331-466781</td>
<td>Fax: 39-0331-742611</td>
</tr>
<tr>
<td>Fax: 972-818-2924</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detroit</td>
<td>China - Nanjing</td>
<td>Philippines - Manila</td>
<td>Philippines - Manila</td>
<td>Netherlands - Drunen</td>
</tr>
<tr>
<td>Farmington Hills, MI</td>
<td>Tel: 86-25-8473-2460</td>
<td>Tel: 63-2-634-9065</td>
<td>Tel: 63-2-634-9069</td>
<td>Tel: 31-416-690399</td>
</tr>
<tr>
<td>Tel: 248-538-2250</td>
<td>Fax: 86-25-8473-2470</td>
<td>Fax: 63-2-634-9069</td>
<td>Fax: 63-2-634-9069</td>
<td>Fax: 31-416-690340</td>
</tr>
<tr>
<td>Fax: 248-538-2280</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indianapolis</td>
<td>China - Qingdao</td>
<td>Singapore</td>
<td>Singapore</td>
<td>Spain - Madrid</td>
</tr>
<tr>
<td>Noblesville, IN</td>
<td>Tel: 86-532-8502-7355</td>
<td>Tel: 65-6334-8870</td>
<td>Tel: 65-6334-8850</td>
<td>Tel: 34-91-708-08-90</td>
</tr>
<tr>
<td>Tel: 317-773-8323</td>
<td>Fax: 86-532-8502-7205</td>
<td>Fax: 65-6334-8870</td>
<td>Fax: 65-6334-8850</td>
<td>Fax: 34-91-708-08-91</td>
</tr>
<tr>
<td>Fax: 317-773-5453</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Los Angeles</td>
<td>China - Shanghai</td>
<td>Taiwan - Hsin Chu</td>
<td>Taiwan - Hsin Chu</td>
<td>UK - Wokingham</td>
</tr>
<tr>
<td>Mission Viejo, CA</td>
<td>Tel: 86-21-5407-5533</td>
<td>Tel: 886-3-6578-300</td>
<td>Tel: 886-3-6578-370</td>
<td>Tel: 44-118-921-5869</td>
</tr>
<tr>
<td>Tel: 949-462-9523</td>
<td>Fax: 86-21-5407-5066</td>
<td>Fax: 886-3-6578-300</td>
<td>Fax: 886-3-6578-370</td>
<td>Fax: 44-118-921-5820</td>
</tr>
<tr>
<td>Fax: 949-462-9608</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Santa Clara</td>
<td>China - Shenyang</td>
<td>Taiwan - Kaohsiung</td>
<td>Taiwan - Kaohsiung</td>
<td></td>
</tr>
<tr>
<td>Santa Clara, CA</td>
<td>Tel: 86-24-2334-2829</td>
<td>Tel: 886-7-213-7830</td>
<td>Tel: 886-7-330-9305</td>
<td></td>
</tr>
<tr>
<td>Tel: 408-961-6444</td>
<td>Fax: 86-24-2334-2393</td>
<td>Fax: 886-7-213-7830</td>
<td>Fax: 886-2-2508-0102</td>
<td></td>
</tr>
<tr>
<td>Fax: 408-961-6445</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toronto</td>
<td>China - Shenzhen</td>
<td>Taiwan - Taipei</td>
<td>Taiwan - Taipei</td>
<td></td>
</tr>
<tr>
<td>Mississauga, Ontario, Canada</td>
<td>Tel: 86-755-8203-2660</td>
<td>Tel: 886-2-2508-6610</td>
<td>Tel: 886-2-2508-0102</td>
<td></td>
</tr>
<tr>
<td>Tel: 905-673-0699</td>
<td>Fax: 86-755-8203-1760</td>
<td>Fax: 886-2-2508-6610</td>
<td>Fax: 886-2-2508-0102</td>
<td></td>
</tr>
<tr>
<td>Fax: 905-673-6509</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>China - Wuhan</td>
<td>Thailand - Bangkok</td>
<td>Thailand - Bangkok</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tel: 86-27-5980-5300</td>
<td>Tel: 66-2-694-1351</td>
<td>Tel: 66-2-694-1350</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fax: 86-27-5980-5118</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>